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December 2018 

What's new 

Read Pearson system announcements within a course  

Pearson general system announcements are now available from the banner (top 
navigation) within MyLab and Mastering courses. Pearson announcements may include 
alerts for planned or unplanned system maintenance, short descriptions of new product or 
software releases, or other important product information. Note: This doesn’t include 
course announcements that instructors send to students. (Released December 17, 2018.) 

Improved accessibility and updated design for My Courses  

The enhanced design of the My Courses page and MyLab and Mastering courses is now 
more accessible to all customers. (Released December 17, 2018.)  

June 2018 

What's new 

New sign in page experience for MyLab and Mastering 

The new sign in page provides faster account access, easier username and password 
retrieval, as well as better assistance for new account registration. (Released June 18, 2018.) 

Chat & ClassLive retirement  

The Chat & ClassLive tool was retired and removed from courses. (Released June 2017.) 

December 2017 

What's new 

Assignment date options for Mastering course copy  

Instructors copying an existing Mastering course can now specify how assignments dates in 
the original course copy over course copies. They can choose to copy exact dates, adjust 
dates based on a new first assignment date, or not copy assignment dates at all. Due dates 
can always be adjusted within the new course. (Released December 19, 2017.) 

New Pearson product names in My Courses list  

The Pearson My Courses list, the catalog, and the course menu now show the new Pearson 
product (series) names, such as MyLab Math, MyLab IT, Mastering Biology, and so on. 
(Released December 18, 2017.)  
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ClassLive tool is retired  

The ClassLive tool is now retired from courses. ClassLive may still appear in the course 
menu with a message shows the ClassLive retirement date. (Released December 18, 2017.) 

November 2017 

What's new 

Updated notification emails and registration instructions 

Course creation confirmation emails and student registration instructions now include not 
only the course name and unique course ID, they also show your specific Pearson product 
(series) name. For most student courses, the student registration instructions includes a 
convenient link to a downloadable PDF that instructors can share with students to help 
them enroll. ] (Released November 30, 2017.) 

July 2017 

What's new 

Enhanced course search 

Students and instructors can use the comprehensive keyword search tool to find their 
courses regardless of location within My Courses. Customers can search by course name, 
course ID, or other course details, such as the course dates. Search results are filtered by 
active or inactive status, and course type (for instructors). (Released July 17, 2017.) 

June 2017 

What's new 

Personal categories  

Students and instructors can personalize the appearance of their My Courses pages by 
creating categories to organize courses and products. Customers can create categories to 
organize courses by semester, discipline, or any other structure that works for them. 
(Released June 17, 2017.) 

Operating system and browser compatibility check  

A browser check message appears upon course launch to notify customers of potential 
performance issues that may occur with outdated browser settings. The operating system 
(OS) and browser compatibility check also ensures that customers' technology is 
configured appropriately to allow pop-ups and cookies. (Released June 15, 2017.) 
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April 2017 

What's new 

Create shortcuts to member sections and student courses  

Instructors can use the pin feature to add shortcuts for easy access to active student 
courses and member sections on the My Courses home page. Customers can work with a 
pinned course in the same way that they would from the student course or member 
sections list, but without the need to open that list. (Released April 26, 2017.)  

December 2016 

What's new 

Enhanced My Courses experience 

The My Courses home page was designed to improve efficiency when working with 
courses. New enhancements build upon the previous design. 

Instructors can now directly open a Coordinator Course or Instructor Course from the My 
Courses page, and open a list of copied courses made from a Coordinator or Instructor 
Course by selecting Active Member Sections or Active Student Courses. A new gear icon 
for  Details clearly indicates where to click to access course actions and information. 

All customers can now conveniently copy the course ID from the tile or list views, quickly 
open courses by clicking anywhere in the area around the course name, and easily 

rearrange courses with the new move icon . (Released December 19, 2016.) 

Improved course creation and copy workflow for instructors 

In the previous design, customers did not clearly understand how to select the various 
actions on the course creation page. The new design now delineates the action buttons for 
searching the catalog, copying by course ID, and copying one of their own existing courses. 
Instructors can choose Select from My Existing Course List to show all of their own 
courses available to copy. (Released December 19, 2016.)  

New edition workflow improvement 

When a new edition is available for existing course material, the option to select the 
current edition is now more intuitively positioned at the top of the page above the new 
edition option. (Released December 19, 2016.)  

New edition courses for Modified Mastering 

Modified Mastering instructors can now copy to new edition courses and retain custom 
content from the prior edition course. Instructors see a New edition available alert for 
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applicable courses on the My Courses page. The Copy Items from Prior Edition tool 
allows instructors to copy their custom menu items to the new edition course. Menu items 
tagged as My Content in the prior course, as well as the uploaded school logo, are 
automatically selected to copy over. All Mastering assignment content is automatically 
updated with changes for the new edition, except for any assigned Dynamic Study Modules 
and customer My Items. (Released December 19, 2016.) 

July 2016 

What's new 

Enhanced course experience for instructors  

The redesigned My Courses from Pearson page for instructors is faster and more stable, is 
fully accessible and secure, and provides improved workflows for catalog searches, and 
creating, copying, and managing courses. The new Active tab allows instructors to easily 
access all of their courses with active enrollments, products with active subscriptions, and 
coordinator and instructor courses. The Inactive tab lists student courses that have ended, 
and the Announcements tab shows all Pearson system announcements. (Released July 20, 
2016.) 

Student registration instructions for LMS integrations 

Student registration instructions are now automatically generated as a PDF for most MyLab 
& Modified Mastering courses, including those linked to another learning management 
system (LMS). The PDF is attached to the course creation confirmation email, and is also 
available from the course details. LMS instructions provide specific steps for each LMS: 
Blackboard, Britespace, Canvas, and Moodle. (Released July 20, 2016.) 

Time-based course access for students 

Students now have the option to purchase limited time-based access to some courses, 
rather than for the full duration of the course. Students can renew access as needed to 
complete course materials. (Released July 8, 2016.) 

April 2016 

What's new 

Email tool enhancements 

Students and instructors can now use the math symbols icon to add equations in the 
MyLab & Mastering Email tool. A new message notifies instructors that they automatically 
receive a copy of every email sent from the Email tool. (Released April 26, 2016.) 
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March 2016 

What's new 

Sign In and password security enhancements 

This release provides better protection for sensitive customer information and an 
improved experience for users who select Forgot your username or password? when 
signing in. When users enter an email address that is associated with a Pearson account, 
they now receive an email to reset their password. Users with multiple Pearson accounts 
will receive one Pearson Username/Password Request email message that includes every 
username associated with their email address, with a separate Reset Password link for 
each username. For better security, new Pearson passwords are case sensitive, and must 
contain at least one capital letter. (Released March 19, 2016.) 

Section instructor email notification 

An email notification is now sent to the primary course owner when a section instructor 
enrolls in a MyLab & Mastering course. (Released March 10, 2016.) 

December 2015 

What's new 

Account enhancements 

Customers can now access their purchase history from their accounts. A new Purchase 
History tab lists all purchase information, including product name, order ID, ISBN (if 
applicable), order date, and purchase price. Instructors can now also edit the first name, 
last name, and title fields in their accounts. (Released December 2015.) 

Manage section instructors 

A new section instructor tool allows the course owner to see a list of all section instructors 
within a course and remove a section instructor, if necessary. (Released December 19, 
2015.) 

MyLab & Modified Mastering course list enhancements 

The MyLab & Mastering course list is renamed to MyLab & Modified Mastering to help 
customers distinguish between Modified Mastering courses and the standalone Mastering 
courses that are listed under Courses and Products. Also, the course list now shows the 
total number of students, teaching assistants, and section instructors for each course. 
(Released December 19, 2015.) 
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Faster course creation time 

The expected maximum time it takes to create a MyLab & Mastering courses has been 
reduced from one business day to three hours. (Released December 19, 2015.) 

Upload your school’s logo 

Instructors can upload a school logo above the course menu to help students visually 
identify a particular course associated with their school. An appropriate school image 
might include the school name, initials, or mascot. Later, instructors can replace the image 
with a different school logo or delete it. If a new edition becomes available for a course, the 
instructor can copy the school logo (along with other custom items) from the prior course 
to the new edition course. (Released December 1, 2015.) 

August 2015 

What's new 

Teaching Staff information on student course details 

Students can now clearly identify additional Teaching Staff (including teaching assistants) 
for their courses by selecting Details on each course tile. The Details view also shows 
Instructors (including section instructors), the course duration dates, role and enrollment 
date, and the last date the student signed in to the course. (Released August 10 2015.) 

July 2015 

What's new 

Course redesign and enhancements for instructors 

MyLab & Mastering is now faster, more stable, and even more powerful, with an intuitive, 
streamlined design and enhanced capabilities on mobile. Instructors can now more easily 
manage course settings and customize course menu items and content on the Edit Course 
Menu page. To learn more, open What’s New from Help . 
(Released July 15, 2015.) 

Enhanced course experience for students  

Students can now use a smartphone or tablet to easily manage their accounts, enroll in 
and open courses, and read announcements. The redesigned interface is faster and more 
stable, is fully accessible, and provides an exceptional user experience through its updated 
visual and interaction design. The new Active tab allows students to easily access all of their 
courses with active enrollments and products with active subscriptions. The Inactive tab 
lists courses with inactive enrollments, and the Announcements tab shows all system 
announcements. To learn more, open What’s New from Help . (Released July 15, 2015.) 
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Maximum course duration set from Course Start Date  

The maximum course duration for a student-enrollable course is now 24 months* from the 
Course Start Dates, rather than the course creation date. This allows instructors to more 
logically set the maximum time students can access courses. The Course Start Date and 
Enrollment Start Date for student-enrollable courses now must be within 90 days of the 
course creation date. *Note: Publishers can define a shorter maximum duration for specific 
course material. (Released July 14, 2015.) 

Student Registration Handout updates  

This release includes updates and corrected workflow steps in the Student Registration 
Handout, which instructors can distribute to students to help them enroll easily in their 
course. The updated handout emphasizes signing in with an existing Pearson account, and 
provides additional temporary access payment instructions. (Released July 14, 2015.) 

June 2015 

What's new 

My Account page enhancements 

The enhanced My Account page provides an updated, simpler experience, improved 
mobile capability, and improved accessibility. Customers can edit their personal account 
information, including email address, username, password, and the security question 
needed for password retrieval. (Released June 18, 2015.) 

March 2015 

What's new 

Block inappropriate discussion responses 

This release allows instructors to block an individual topic response and any replies that 
build on it from showing to other students, due to inappropriate content. The release also 
includes better visual grouping of topic responses and replies, and other style and text 
improvements. (Released March 19, 2015.) 
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December 2014 

What's new 

CourseCompass retirement complete — Effective December 2014 

All Earlier Edition MyLab (CourseCompass) courses have been permanently deleted as of 
December 2014. These courses no longer appear in the course list. (Released December 5, 
2014.)  

Discussion enhancements  

This release includes user experience enhancements, including improved sorting and 
search tools for topic responses, new Question and Recommendation features, and a 
streamlined, intuitive design. The Question option allows an instructor to pose a question 
to the students, or allows students to flag a question for the instructor or classmates. The 
Recommendation option allows instructors to positively rate a particular post. (Released 
December 18, 2014.) 

Secure Sign-in (SSL) 

MyLab & Mastering users now see “https” in the URL for the sign-in page 
(https://portal.mypearson.com/portal) indicating secure processes for collecting their 
usernames and passwords. (Released December 22, 2014.)  

Sign In with YUZU 

A new Sign In with YUZU option allows students who have already enrolled in a Pearson 
course through YUZU to sign in directly through MyLab & Mastering. (Released December 
22, 2014.)  

Improved MyLab & Mastering messages and design 

The MyLab & Mastering welcome message for new users now provides better getting-
started information. A Modified Mastering label allows users to quickly locate their 
Modified Mastering courses. The New Design label was removed from the course list, 
following the retirement of Earlier Edition (CourseCompass) courses. (Released December 
22, 2014.)  
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November 2014 

What's new 

Additional course types available when copying a coordinator or member section 
course in a third-party LMS 

Additional course types are now available for some products when copying coordinator or 
member section courses in anther learning management system, such as Blackboard, 
Moodle, Desire2Learn, or Canvas. Selecting an instructor-only course type always prevents 
student enrollment. (Released November 10, 2014.) 

August 2014 

What's new 

Math equation editor accessibility and enhancements  

This math equation editor release includes improved screen layout, addition of accessibility 
for users with screen readers, and an increased selection of equations. (Released August 
05, 2014.) 

Direct links to Document Sharing files 

Instructors can now create links from assignments and other content items to uploaded 
files in the Document Sharing tool. Students click the link to directly access the Document 
Sharing file, without needing to navigate through the course menu. (Released August 1, 
2014.) 

July 2014 

What's new 

Section instructor access for MyITLab 2013 

Users of MyITLab 2013 may register directly as a Section Instructor, rather than enrolling 
first as a student and then being promoted in the roster. (Released July 29, 2014.) 
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Additional course types available when copying a coordinator or member section 
course 

Additional course types are now available for some products when copying coordinator or 
member section courses, simplifying the process of creating other coordinator or member 
section courses. Instructors are given new options of the type of course to be created: 
Coordinator Course For Instructor Use Only, and Member Section Course For Student 
Enrollment. Selecting an instructor-only course type will always prevent student 
enrollment. (Released July 29, 2014.) 

Expanded country list for the Middle East region 

The Middle East region definition has been expanded to include the following countries: 
Bahrain, Egypt, Iraq, Jordan, Kuwait, Lebanon, Oman, Qatar, Saudi Arabia, Syria, Turkey, 
United Arab Emirates, and Yemen. (Released July 29, 2014.) 

June 2014 

What's new 

CourseCompass course retirement — Effective June 23, 2014 

All Earlier Edition MyLab (CourseCompass) courses have been retired as of June 23, 2014. 
This means all access to these courses is unavailable, including grades and customized 
materials. The courses will remain in the courses list until December, 2014 for reference. 
After that time they will be removed. (Released June 23, 2014.) 

New My Content tag for custom content 

Instructors can now tag their custom content items with the new My Content tag to 
automatically select them when copying to a new edition of the course. This eliminates the 
need to recreate custom items in the new course. By default, all items created by the 
instructor are automatically tagged as My Content. (Released June 18, 2014.) 

Resolved issues 

Accessibility updates for Syllabus  

The Syllabus tool is now accessible and compatible with the JAWS screen reader. (Released 
June 16, 2014.) 
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May 2014 

What's new 

New edition (course copy) enhancements 

When available, users can click New Edition Available to update their MyLab & Mastering 
new design courses to a new edition. Users can now select which custom content items to 
copy into the new edition course menu, and any linked files from those items copy to the 
File Manager in the new course. Previously, new edition updates were only available for 
Earlier Edition (CourseCompass) MyLab courses. (Released May 23, 2014.) 

CourseCompass course retirement 

The last day instructors can access their Earlier Edition MyLab (CourseCompass) courses is 
June 22, 2013. All CourseCompass courses will be disabled as of June 23, 2014. Course 
Details will remain available for reference only, and course-specific Announcements will no 
longer be available on the MyLab & Mastering Courses page. (Released May 23, 2014.)  

New insert media icon in Discussions editor 

The new media icon in the visual editor toolbar allows instructors and students to embed 
media directly within threaded discussion posts alongside text, without the extra step of 
adding an attachment. Options include adding a URL for a photo or video, or embed code 
for any type of media that can be viewed directly in the post. This eliminates the need for 
attachments or leaving the discussion to view media. (Released May 21, 2014.) 

Automatic saves (autosave) for responses in Discussions 

Autosave for discussion responses prevents students and instructors from losing unsaved 
discussion responses due to browser crashes, system timeouts, or any unexpected or 
accidental closure of the browser. To resume writing, users open the course with the same 
browser, then navigate to the same discussion topic and click Respond. (Released May 12, 
2014.) 

April 2014 

What's new 

New region-specific catalogs 

MyLab & Mastering now includes region-specific course catalogs for customers in the 
Middle East and Australia regions. (Released April 2, 2014.) 
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CourseCompass course retirement 

Earlier Edition MyLab (CourseCompass) course listings will show course retirement and 
deletion messages to support the overall CourseCompass retirement effort. In addition, the 
ability to create new CourseCompass courses, including by copying Personal Edition 
courses, will be disabled after April 15, 2014. Please check the Announcements on the 
courses page for important retirement dates (Released April 2, 2014.) 

March 2014 

What's new 

New Update Gradebook tool aligns assessment points 

The new Update Gradebook tool in assessments allows instructors to align total points 
possible in the gradebook with new points assigned to questions within the assessment. 
This tool prevents point conflicts between the gradebook and assessments, ensuring that 
points for student work and grade to date information are recorded accurately. Note: Not 
all courses use the same assessment types or gradebook. (Released March 24, 2014.) 

Resolved issues 

Gradebook points updated automatically when manually grading answers 

An issue in which the total points for an assignment were not updating automatically in the 
gradebook summary when manually grading student answers (until the instructor 
manually refreshed) has been resolved. Total points for an assignment now update 
automatically in the gradebook as the instructors saves new points for student answers. 
Note: Not all courses use the same gradebook. (Released March 03, 2014.) 

January 2014 

What's new 

Performance Reporting message: No Grade to Report 

The message NO GRADE TO REPORT appears in Performance Reporting for a specific 
gradable assignment if either the student has not yet taken it (if it is an auto-graded 
assignment) or the instructor has not yet graded student work (if it is a manually-graded 
assignment). Note: Not all courses use the same gradebook. (Released January 3, 2013.) 



Copyright © 2019 Pearson All Rights Reserved 15 

Resolved issues 

Gradebook Export includes all enrolled students in the course 

An issue in which only students with grade data were included in the gradebook export file 
has been resolved. Now all enrolled students in a course are listed in gradebook export csv 
files. Also, if an instructor has taken a preview assessment, his name is no longer listed in 
the export file. Note: Not all courses use the same gradebook. (Released January 10, 2014.) 

December 2013 

What's new 

External links now copy to new edition courses 

When copying from an earlier edition course to a new edition (by clicking either New 
Edition Available or Update to New Design in the Courses list), external link items are 
now copied into the new edition course copy. The items appear in the new course menu in 
a folder External Links-1 within the Copied from [old course ID] folder. All attachments 
from the prior edition course are copied into the File Manager. (Released December 5, 
2013.) 

Threaded Discussion enhancements 

Instructors can now hide specific topics from the student view when adding or editing 
topics. The new Post first option allows instructors to hide other responses for a topic until 
a student first responds to that topic. The new course-level Discussions Settings give 
instructors the ability to hide or show discussion topics throughout the course, allow 
students to edit their own responses, display a first line “Preview” of each response, and 
show a total and unread response count in the Topics list. (Released December 18, 2013.) 

Temporary access enhancements 

Temporary access duration is now 14 days from registration date. Also, usability was 
improved for students with expired temporary access. (Released December 19, 2013.) 

Registration enhancements 

This release brings numerous improvements to MyLab & Mastering registration including 
updated branding, accessibility, user assistance, and better learning management system 
(LMS) integration for returning Blackboard, Canvas, or Desire2Learn users. (Released 
December 19, 2013.) 

Course roster export option 

Instructors can export the roster to a comma separated value (CSV) file. The exported 
roster includes the student Name, User ID, Email, whether the student has access to the 
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roster, and the most recently saved Role and Status information. If temporary access was 
used by the student that information is also provided including whether the access has 
expired and the expiration date. (Released December 23, 2013.) 

MyLab & Mastering courses list and course creation enhancements 

This release features course creation workflow improvements and brand updates to the 
MyLab & Mastering courses list. For example, the main areas were renamed as 
MyLab & Mastering and Courses and Products. Mastering products are identified with a 
Modified label, while MyLab courses retain a New Design! label. A new Enroll in a Course 
button provides easy course registration access for non-course-based (subscription only) 
users. Course creation workflow enhancements include more helpful tool tips for 
instructors, as well as clear on-screen instructions for creating coordinator courses and 
integrated learning management system (LMS) courses. (Released December 23, 2013.) 

Submissions Grading 

This release enables instructors to grade submission assignments directly from the 
Submissions tool, without having to navigate to with the Gradebook. Note: Not all courses 
use the same gradebook. (Released December 27, 2013.) 

Writing Space enhancements 

Links to the Pearson Writer's Guide and to Pathbrite are now available from the student 
Tools. Instructors can enable or disable the links for individual assignments. (Released 
December 28, 2013.) 

Known issues 

No more than 300 custom items are copied to a new edition from the original, earlier 
edition course 

When copying from an earlier edition course to a new edition (by clicking either New 
Edition Available or Update to New Design in the Courses list), no more than 300 custom 
items from the original course will copy into the new edition course copy. A custom item 
includes any item in the original course that was added, edited or reordered by the 
instructor. Most courses won’t reach the limit, but highly customized courses may, 
especially courses with many reordered content items. Assessments are given priority over 
other content items when copied to a new edition, and can be viewed by clicking Imported 
Assessments in the menu. A menu item Error Log is created in the new edition course to 
report when the item limit was reached during the copy process. (Released December 5, 
2013.) 
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November 2013 

What's new 

Students submit answers only on final page of assessments 

Students can now only submit their answers for multiple-page assessments when they 
reach the final page of the assessment, ensuring that they see all questions before 
submitting. Instructors can set up multiple-page assessments to show either one section 
per page or one question per page. Note: Not all courses use the same assessments. 
(Released November 19, 2013.) 

October 2013 

What's new 

New name for Blackboard gradebook export option 

The Export Gradebook option for Blackboard is now Blackboard-MyLabMastering .csv. 
(Released October 30, 2013.) 

Resolved issues 

Students cannot submit the same assessment twice in the same session 

An issue in which a student could sometimes submit the same assessment more than once 
in the same session has been resolved. (Released October 2, 2013.) 

Students can view long comments in the gradebook 

An issue in which students could not view the complete text of long gradebook comments 
has been resolved. Students can now view long comments by hovering over the comment 
in the gradebook. (Released October 30, 2013.) 

Assignment calendar time now matches assessment time 

An issue in which assessment availability dates differed from the instructor setting by one 
hour has been resolved. An adjustment for Daylight Saving Time was released. All 
assessments scheduled after this release will now convert to the correct time zone setting, 
and match the availability times that appear in the assignment calendar. (Released 
October 31, 2013.) 
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September 2013 

What's new 

Outcome Summary now shows menu paths for tests 

The Outcomes Summary tab in Performance Reporting now shows the full course menu 
path when hovering over the pre-test and post-test associated with a particular learning 
outcome. (Released September 22, 2013.) 

Resolved issues 

Unable to see all students in large gradebooks 

An issue in which not all enrolled students were visible in the Gradebook Overview for large 
classes (over 125 students) has been resolved. All students now show in in large 
gradebooks. (Released September 16, 2013.) 

Assessments issues in Chrome browser 

Several issues in which assessment questions could not be added or edited, and 
assessment sections could not be reordered in Chrome 29 have been resolved. Note: Not 
all courses use the same assessments. (Released September 25, 2013.) 

August 2013 

What's new 

For Review enhancements  

For Review on the Course Home now correctly lists only students’ Submission items and 
manually-graded assessments (that is, those assessments set in Configuration to Hide 
score from student and I will manually share the grade). Instructors dismiss items from 
For Review by returning assignments in the Submissions tool, and grading manually-graded 
assessments in the gradebook. Automatically-graded assessments do not appear in For 
Review. (Released August 14, 2013.) 

MyLab & Mastering website enhancements 

The Pearson MyLab & Mastering website (www.pearsonmylab.com; 
www.pearsonmylabandmasting.com) is redesigned to more effectively convey MyLab & 
Mastering brand value, improve usability and access to discipline-specific content, and 
provide better support for international customers. (Released August 17, 2013.) 
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Simulations easier to save for students 

A new Save & Exit button and improved messages in simulation (SCORM) assignments 
ensures that students save their results before closing the browser window, so scores 
correctly post to the gradebook. (Released August 15, 2013.) 

Writing Space peer review assignments 

With new peer review assignments, students write an initial draft, and Writing Space routes 
it to instructor-defined peer group members for review. A student then receives and 
incorporates the reviews and submits a final draft. Instructors review and comment on the 
final drafts, grading students based on both their writing and peer reviews. (Released 
August 29, 2013.) 

Writing Space posts scores to gradebook 

Grades returned by the instructor from within the Writing Space tool now post to the 
course gradebook. When an instructor changes a score for a writing assignment in the 
writing assignment then clicks Save Grade, the new score posts to the course gradebook. 
Note: Not all courses use the same gradebook. (Released August 29, 2013.) 

Percentage and Points to Date available in student gradebooks 

Students now see grade to date information in their gradebooks, which includes 
cumulative Points to Date and Percentage achieved. (Released August 30, 2013.) 

Resolved issues 

Instructors see blank assignment details after refreshing Writing Space assignment 
page 

After refreshing the browser, instructors now correctly see the content on writing 
assignment pages. This is a limited feature, and not available in all courses. (Released 
August 1, 2013.) 

Submissions settings do not carry forward to course copies  

An issue in which submissions settings did not carry forward to course (child) copies has 
been resolved. All submissions settings now carried forward to all course copies. (Released 
August 14, 2013.) 

Instructors can view question-level comments 

An issue in which instructor could not later view their own question-level comments in a 
student’s gradebook Details View has been resolved. Instructors can now view question-
level comments at any time, regardless of the assessment’s Review Date settings. (Released 
August 15, 2013.) 
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July 2013 

What's new 

Calendar links open assignment items 

Students and instructors can now directly open assignments items from Assignment 
Calendar due date and availability links. Scheduled study plan pre-test and post-test links in 
the calendar open the associated study plan item. Note: Not all courses use this calendar. 
(Released July 24, 2013.) 

Gradebook stability and performance enhancements 

This upgrade improves performance, stability, browser support, and accessibility of the 
gradebook. Note: Not all courses use this gradebook. (Released July 29, 2013.) 

Gradebook warning for unsubmitted student assessments 

A new warning message in the gradebook Details View alerts instructors if a student has 
not yet submitted an assessment: “This student is in the process of taking this exam and 
the score displayed in the summary below may not match the current grade in the 
gradebook.” Instructors can see this warning until the student submits the assessment, or 
the instructor resets the assessment. Note: Not all courses use this gradebook. (Released July 
1, 2013.) 

Resolved issues 

Resolved Blackboard Learn gradebook issue 

Instructors can now make edits to gradebook column information to more easily transfer 
grades from MyLab & Mastering into Blackboard Learn. Instructors can change the name, 
category, and display (for example, show as percentage). (Released July 27, 2013.) 

June 2013 

What's new 

Writing Space two-draft assignments 

Instructors can now set up two-draft writing assignments where each draft has its own due 
date, and the instructor can provide feedback on both drafts. (Released June 26, 2013.) 

Writing Space assignment originality check 

Student submissions can be sent to Turnitin® for an originality check. The check searches 
the Internet and a repository of student submissions for similar or copied text, and returns 
a similarity score and report. (Released June 26, 2013.) 
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Resolved issues 

Default settings for assessment import packages 

Imported assessment packages, such as TestGen, now default to the assessment 
Configuration option Display score to student and share grade automatically. This 
release also fixes an issue where imported assessment questions defaulted to 10 points in 
the assessment. This has been resolved so that the imported questions now default to 
1 point per question. (Released June 27, 2013.) 

May 2013 

What's new 

Full Credit Only grading option for multiple answer questions 

The assessment Configuration page now provides a default Full Credit Only setting for all 
multiple answer question types within the selected assessment. When this setting is 
selected a student must select all correct answer options (and not select any incorrect 
answer options) in order to receive credit for each multiple answer question. (Released 
May 28, 2013.) 

Back to Study Plan links from pre-test and post-test 

Students can click Back to Study Plan after taking a pre-test and post-test to return to the 
study plan item. This is a limited feature, and not available in all courses. (Released May 8, 
2013.) 

Study plan progress reports for instructors 

Instructors view class-level and individual student progress on a study plan by clicking the 
Student Progress tab. The default Class Overview shows all students’ progress within the 
selected study plan. Instructors can also view an individual student’s progress the pre-test, 
post-test, and if the student completed review of study materials (remediation content) for 
the learning outcomes. This is a limited feature, and not available in all courses. (Released 
May 8, 2013.) 

Dynamic Study Modules 

New Dynamic Study Modules help students check and improve their knowledge of the 
material they must master to do well in the course. As a student progresses through sets of 
questions, these modules provide practice and feedback in areas where the student needs 
more review. This is a limited feature, and not available in all courses. (Released May 20, 
2013.) 



Copyright © 2019 Pearson All Rights Reserved 22 

Resolved issues 

Unicode support for Multiple Choice and Multiple Answer 

Unicode is now supported for answer choices in Multiple Choice and Multiple Answer 
question types. (Released May 29, 2013.) 

April 2013 

What's new 

Study plan links to pre-test and post-test results 

Students can view their pre-test and post-test results at any time by clicking Pretest or 
Posttest in the new Results area of the study plan item. This is a limited feature, and not 
available in all courses. (Released April 8, 2013.) 

Resolved issues 

Assessment Configuration options updated for Results Features 

The Results Features options on the assessment Configuration tab better describe the 
interaction with the gradebook. The options are: Display score to student and share 
grade automatically and Hide score from student and I will manually share the grade. 
(Released April 2, 2013.) 

March 2013 

What's new 

Performance reporting progress bar, configuration tab, and grade band 
customization options 

The progress bar shows instructors a visual representation of class performance on 
assessments. The new Configuration tab allows instructors to customize the progress bar 
to show only assignment calendar assignments (the default) or all gradable assignments in 
the course. Instructors can also configure the grade band percentage ranges. (Released 
March 19, 2013.) 

Resolved issues 

Printing large rosters 

An issue in which it was impossible to print large course rosters has been resolved. 
Instructors can now print complete course rosters. (Released March 29, 2013.) 



Copyright © 2019 Pearson All Rights Reserved 23 

January 2013 

What's new 

MyLab / Mastering Mobile Dashboard 

For some courses, this app provides a mobile dashboard for announcements, assignment 
due dates, grades and progress to help students stay on track and up to date. Students see 
a link to the app in their courses list next to each supported course: Get the Mobile App 
for this Course. This is a limited feature, and not available in all courses. (Released January 
2013.) 

Assessment default configuration and messaging enhancements 

Students who navigate away from an assessment before submitting it now receive a 
warning message. Instructors receive a related message in the gradebook details when a 
student has not submitted an assessment. Also, the default configuration setting for 
assessments is now Save answers and end exam when time limit is reached. This 
default is not retroactive to existing assessments. (Released January 8, 2013.) 

Edit course settings within a new design course 

Streamlines instructor access to view, edit, and print the course settings and roster from 
within the open course. (Released December 12, 2012.) 

Math editor in student discussions  

The math equation editor is now available to students within discussions. Students can add 
equations within their discussion responses. (Released November 26, 2012.) 

Validator tool added to Visual Editor  

The code validator tool is available to instructors in the toolbar of the Visual Editor. 
Instructors and producers use the tool to check html coding when creating custom content. 
(Released November 26, 2012.) 

Gradebook updates 

The gradebook has a new look and feel and added functionality to select all students for 
grade sharing. (Released December 2012.) 

Graded Writing Space writing assignments 

Instructors can use prebuilt Writing Space writing assignments and a rich set of tools to 
evaluate students’ writing using preset rubrics and automatic or manual grading. This is a 
limited feature, and not available in all courses. (Released December 2012.) 
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Update to New Design 

Instructors can update from an earlier edition course to a new design version if Update to 
New Design appears under the course's name in the courses list on the MyLab / Mastering 
courses page. (Released December 12, 2012.) 

Resolved issues 

Course title change now updated in Student Registration Handout/PDF 

The auto-generated Student Registration Handout/PDF updates when the instructor edits 
the course name in course settings. (Released December 12, 2012.) 

Students can pay for temporary access after enrollment end date 

Students can now pay for temporary access after the course’s enrollment end date. 
Students can pay for access either by clicking the payment link provided in the temporary 
access email, or by signing in to pearsonmylabandmastering.com and entering the course 
ID on the payment page. (Released December 15, 2012.) 

Blackboard Learn course reset 

From within the Blackboard Learn Support Tools, instructors can now use the Reset 
MyLab / Mastering Course Association tool to unmap a Pearson MyLab and Mastering 
course without assistance from Support. Resetting the course association between a 
Blackboard Learn course and a MyLab / Mastering course deletes the MyLab / Mastering 
course and student results. (Released December 2012.) 

Known issues 

Internet Explorer 8 is not a supported browser 

IE8 is no longer a supported browser for MyLab and Mastering new design courses. For the 
best course experience, see the system requirements for a list of supported browsers. 
(Released December 2012.) 

October 2012 

What's new 

Student reporting and standards enhancements 

The performance reporting Outcomes Summary tab can now include standards bodies 
headings within the standard lists associated with learning outcomes, as identified by 
course producers. Performance reporting now includes the last time each student signed 
in, as well as a pie chart distribution of student results ranges. This is a limited feature, and 
not available in all courses. (Released October 17, 2012.) 

http://pearsonmylabandmastering.com/system-requirements/
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Blackboard 9.1 gradebook export 

The gradebook now includes an option to export grades for Blackboard 9.1 .csv. This 
includes a new BB Student ID data field in the output file. (Released October 8, 2012.) 

Assignment calendar 

Assignment calendar allows instructors to set due dates for assignments, and provides 
both students and instructors several calendar views to keep track of assignment 
availability and due dates. This is a limited feature, and not available in all courses. (Released 
June 28, 2012.) 

Performance reporting 

Instructors can use performance reporting to monitor class and student progress. This is a 
limited feature, and not available in all courses. (Released July 25, 2012.) 

Study plan 

Instructors use prebuilt study plans to monitor student mastery of learning outcomes. 
Students click the study plan menu item to guide them through the pre-test, study 
materials, and post-test. This is a limited feature, and not available in all courses. (Released 
August 2012.) 

Linked Content menu item type 

When building customized content, instructors can associate a website URL with a menu 
item and add it to the course menu. When a student clicks the menu item, the website 
displays in a new browser window. This is a limited feature, and not available in all courses. 
(Released August 2012.) 

Resolved issues 

Sign out in Internet Explorer 8  

Users who now click Sign Out within a new design course using IE 8 are signed out 
successfully. (Released October 17, 2012.) 

August 2012 

What's new 

New customized student registration handout 

The confirmation email now provides a Student Registration Handout PDF file, which 
includes the course ID required for student registration and other important course 
information. Instructors can give the handout to students to enroll in courses. Instructors 
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can access the handout at any time by clicking Details in the courses list to open Course 
Details. (Released August 25, 2012.) 

Course lifecycle changes 

Students cannot access a course beyond the course end date, a maximum of 24 months 
after the course creation date. Instructors can access to the course until it is deleted. When 
the course reaches its maximum end date, it enters a 3-month course retirement phase. 
During this phase, several email alerts remind instructors that the course is flagged for 
deletion. (Released August 25, 2012.) 

Default course dates removed 

There are no longer default course end dates, or course enrollment start and end dates. Instructors 
must specify these dates when creating courses. The default course start date is still the same as the 
course creation date. (Released August 25, 2012.) 

Blackboard Learn integration 

Pearson's MyLab and Mastering online courses are now available with Blackboard Learn. 
Students only need to sign in once to access courses, and instructors can access a MyLab 
and Mastering course from Blackboard, link to the course content, and import grades from 
the Pearson gradebook into Blackboard Learn. (Released August 25, 2012.) 

Known issues 

Enhanced Course Home Not Supported in IE 8 

The enhanced Course Home features do not work in Internet Explorer 8. When attempting 
to access the Course Home, an error appears, "Stop running this script?..." This may occur 
when you first open your course, or if you click Course Home in the course menu. To 
access your enhanced Course Home features, including Activity, People, Articles, 
Announcements, Upcoming, and For Review (for instructors), use another supported 
browser. For best performance, use the most current version of Chrome or Firefox. Please 
see the system requirements page for a list of supported browsers. A fix is not planned for 
this issue. 

July 2012 

What's new 

Articles feed in Course Home 

Instructors can use Articles to share RSS (Really Simple Syndication) feeds, such as news 
websites, blogs, and podcasts, with students on the Course Home. The Articles feed 
appears on the instructor’s Course Home by default. Students also see Articles in the 

http://pearsonmylabandmastering.com/system-requirements/
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Course Home after the instructor add the first feed, and can view each article in a new 
window by clicking Read More. (Released July 6, 2012.) 

Assessment reset and additional time options 

From the gradebook, instructors can reset a student’s assessment, as well as extend 
assessment time limits for students. (Released July 6, 2012.) 

Assessment views enhancements  

A new interface allows instructors to more easily review and configure assessments by 
clicking Preview Assessment or Manage Assessment. Assessment performance 
information is viewed by clicking View Statistics from the assessment menu item. 
(Released July 6, 2012.) 

Course roster enhancements 

The course roster allows section instructors to edit, change student enrollment status, 
search for students and promote students to the role of section instructors, if the Roster 
Access option is selected. A search tool allows instructors to more easily locate a student in 
a large roster list, and a new print roster option is available. Instructors also view students’ 
temporary access status within the course roster. (Released July 6, 2012.) 

Course customization enhancements 

Improvements to the modify course menu options allow instructors to more easily and 
quickly add, arrange, and configure course menu items, especially for a large number of 
menu items. (Released July 6, 2012.) 

Gradebook export 

By clicking Export Gradebook in the gradebook, instructors save the course’s grade data to 
a Microsoft Office Excel Comma Separated Value (.csv) file. The exported data includes the 
First Name, Last Name, and Email Address for each student; Points earned by students for 
each assessment taken; and, a column for each gradebook item, which includes the item 
name, a system-generated reference ID number, and the total possible points for the item 
set by the instructor. (Released July 6, 2012.) 

June 2012 

Resolved issues 

Course scheduler displays menu items list  

An issue preventing menu items from displaying correctly in the left-side navigation of the 
course scheduler has been resolved. (Released June 28, 2012.) 
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April 2012 

What's new 

Multiple file upload for submissions 

Instructors and students have the option to upload multiple files to a submission. A 
numerical count for all student submissions waiting for review, All Submitted for Review, 
is now displayed for instructors in the submissions tool. (Released April 4, 2012.) 

March 2012 

What's new 

Assessment availability settings 

Instructors can set the availability of an assessment by clicking Schedule within an 
assessment, then setting dates for Availability from: and to: by clicking the calendar 
icons. (Released March 28, 2012.) 

Enhanced hide/show course menu and expand/collapse to full screen features 

A new feature allows both instructors and students to hide the course menu (navigation) to 
display content better without hiding the course banner. Users still have the option to 
expand the content pane to full screen, which hides both the course menu and the banner. 
These features toggle to again display the course menu and the banner links. (Released 
March 27, 2012.) 

New hidden icon in course menu 

A new icon indicates that a menu item in the course menu is hidden from students: . 
(Released March 27, 2012.) 

Renamed course settings menu 

The modify settings menu was renamed to course settings in this release. (Released 
March 27, 2012.) 

More colors options for Style 

Additional color choices are available in the Style menu to allow instructors to color code 
multiple sections of a course, for example. (Released March 27, 2012.) 

Scrollbars added to course menu 

A scrollbar now appears in the course menu to assist navigation with long or expanded 
course menus. (Released March 27, 2012.) 
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Resolved Issues 

Dual scrollbars 

An issue where dual scrollbars appeared if the content extended beyond the content pane 
has been resolved. 

February 2012 

What's new 

Extended session timer 

The course session timer was increased from a limit of 90 minutes to 120 minutes. User 
input, such as pressing a key, mouse click or mouse movement, resets the session timer 
back to 120 minutes keeping the session live. Some products, such as MyMathLab, allow 
the session to extend an additional 120 minutes, for a total of 240 minutes. Also, students 
taking an exam in another window in the course will no longer see the a session expiration 
message while actively taking a test. After the session timer expires, the message "Your 
session will expire soon" appears. Users then have 10 minutes to extend the session by 
clicking Continue my session. (Released February 23, 2012.) 

Improved Modify Course Menu performance 

Users will now experience improved loading time and stability when accessing the Modify 
Course Menu to customize their courses. Click modify above the course menu to open the 
Modify Course Menu. (Released February 23, 2012.) 

Resolved issues 

Default assessment review date prevents students from viewing results  

An issue in which assessment review dates were set to 12/28/2030 by default, thus 
preventing students from viewing results, has been resolved. The default review date for 
assessments is now set to 12/28/10. 

Return to Gradebook overview from Grade by Assignment 

When viewing a student's assignment in Grade by Assignment, an instructor can now click 
Back to Overview to return to the Gradebook. 

Numbers display with correct comma format 

An issue where numbers were not formatted correctly has been resolved. Numbers now 
correctly display with commas. 
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January 2012 

What's new 

New Design course timeout is now extended to 120 minutes 

Users now remain signed in to a new design course during 120 minutes of inactivity. After 
120 minutes, users should click OK to stay signed in to the course when the "Your session 
is about to expire" message appears. (Released January 17, 2012.) 

Copy to New Edition (CTNE) enhancements 

Content Items. Users can now import all menu items and content pages from an older 
edition MyLab course to new design course. After the CTNE process is complete, the 
imported contents appear as Copied from [old course ID] in the course menu of the new 
design course. All uploaded content from the original course is available in the new design 
course. Click modify settings > Manage Files, and expand the My Files from Prior 
Editions folder to view the files imported from your prior edition. You can link to these files 
from content menu items by using the content editor. 

Assessments. Users can now import assessments created in older edition MyLab courses, 
including the following assessment types: TestGen, fill in the blank, multiple choice, essay, 
matching, true/false, and multiple response. Click Imported Assessments in the new 
design course menu to view imported assessments. (Released January 24, 2012.) 

Answer level feedback for Assessments 

Instructors can now add answer-level feedback for multiple choice, multiple answer, and 
true/false. (Released January 30, 2012.) 

Reset Student Assessments 

Instructors can now reset a particular student’s assessment. To do this, click Gradebook,  
then click the score for a particular student and assessment. In the next menu, click View 
Details, then click Reset Student Assessments under Details. (Released January 30, 2012.) 

Resolved issues 

Undefined assessments in Schedule tab display correctly 

An issue displaying "NaN" for undefined dates for assessments on the Schedule tab has 
been resolved. This issue only affected Chrome and Safari users. 

Assessment time limit can now be set to zero 

Assessments can now be saved and submitted if the time limit is disabled or set to 0. The 
clock appears, displaying 00:00:00.  
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Known issues 

Course scheduler does not display menu items list  

Issue: In some newly-created MyLab and Mastering new design courses, the menu items 
list does not appear on the left side of the calendar when using the course scheduler. It is 
not possible to view or schedule the items using course scheduler. This issue occurs in any 
browser. 

Workaround: This issue appears in new courses only, and only on the same day they are 
created. The issue is self-correcting: The course scheduler with the menu items list will 
display correctly the day after the new course is created. A fix is planned for a future 
release. 

Note: You typically set due dates for assessments by clicking the assessment in the course 
menu, clicking modify > Manage, then Schedule. Assessment due dates default to the 
course duration. However, due dates set within an assessment do not appear on the 
course scheduler or its associated Upcoming list. 

Copy to New Edition (CTNE) cannot copy more than 450 modified menu items from 
the original course 

Copy to New Edition (CTNE) cannot copy more than 450 modified items from the original 
course into the new design course. A "modified item" includes any item in the original 
course that was added, edited or reordered by the instructor. Most courses won’t reach the 
limit, but highly customized courses may, especially courses with many reordered content 
items. 

A menu item Error Log is now created in the new design course to report when the item 
limit was reached during CTNE. The Error Log item displays: "Currently, there is a limitation 
on the number of items that can be carried forward from a previous course during the 
Copy to New Edition process. The first 450 items from your previous course will have 
copied successfully, but all others have been omitted and will need to be manually re-
added. We apologize for the inconvenience and plan to address this in a future release." 
Assessments are given priority over other content items when copied to a new edition, and 
can be viewed by clicking Imported Assessments in the menu. 

Math Equation Editor limitation for Copy to New Edition (CTNE) 

Items that contain equations created with Math Equation Editor in older edition MyLab 
courses cannot be copied to the new design course using Copy to New Edition. This is due 
to a limitation in the CTNE process and new design courses, which cannot resolve the 
external image references created by Math Equation Editor in the original course.  

Default assessment review date prevents students from viewing results  

When you create your course, assessment review dates are set to 12/28/2030, by default. 
The review date is the date when students can see the results of an assessment—the 
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correct answers, as well as their own answers. A review date set in the future prevents 
students from sharing answers. The concept checks and review questions in your course, 
however, are designed to help remediate student misconceptions. The goal is for students 
to learn from their mistakes by seeing their results immediately. 

You can resolve this issue so that your students can see their answers immediately. To do 
so, follow the steps below. 

To replace default review dates: 

1. In the course menu, click an assessment, such as a Concept Check or a set of Review 
Questions. 

Be sure to expand the course menu to perform this procedure on each assessment. 

2. On the assessment page, click modify > Manage in the upper-right. 

3. Click Schedule at the top of the page. 

4. Click in the Review Date field on the right where the date of 12/28/2030 displays. 

A calendar appears. 

5. Beneath the calendar, click 2029, to the left of the highlighted year, 2030. 

The year 2028 displays beneath your cursor. 

6. Click 2028, and continue clicking the decreasing years that display: 2027, 2026, 2025, 
until you reach 2012. 

The year 2012 is highlighted below the calendar. 

7. Now, click the month menu above the calendar and select the current month. 

8. Select today’s date or any preceding date. 

Today’s date is underlined in the calendar. 

9. Click Save.  

Now the Review Date for the assessment is set so that your students can see each 
question’s answers immediately, as well as their own answers. 

10.  Repeat this procedure for each assessment in your course. 

Note: In an upcoming software release, this issue will be resolved; assessment review 
dates for your course will be set in the past, so that your students will see their answers 
immediately. Students will also be able to view detailed discussions of each question in an 
upcoming software release. 
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December 2011 

What's new 

Mastering New Design course pages now appear in frame  

Some pages in Mastering New Design courses now appear within the course frame. For 
example, Item Library, Assignments, Roster, and Grade Book pages now appear in frame 
instead of in pop-up windows. (Released December 22, 2011.) 

Resolved issues 

Email Subject text includes course title 

Email Subject text now automatically includes the course title. Note: This applies only to 
new courses, and is not retroactive to courses created before this release date.  

Error pages link to the sign in page 

Error pages now provide a link to direct users back to the sign in page.  

User creation and enrollment time out 

A timeout issue that interrupted user creation causing enrollment to fail has been resolved.  

Users' course titles are shown in People view 

A list of course titles now appear under each user's name in the enhanced Announcements 
People view. The course title list includes all courses in which the user is enrolled. 
Note: This applies only to new courses, and is not retroactive to courses created before 
this release date.  

Known issues 

Can't create link in assessment Introduction; ampersand character (&) not accepted 

Issue: An error occurs when adding a URL to a link an assessment's Introduction if the URL 
contains an ampersand (&) character. For example, after entering the following URL in the 
URL box, the error "The value entered is not valid" appears: 

http://media.pearsoncmg.com/ph/bp/bp_mylabs/akamai/template/video640x480.php?title
=azTeen_Magazine&clip=pandc/bp/2010/management/azteen.mov&caption=bp/bp_mylab
s/akamai/2010/management/xml/azteen.adb.xml 

Workaround: 

1. Click an assessment menu item in the course menu. 

2. Click modify > Manage. 
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3. Click Introduction. 

4. Click the Create Link icon to open the Link Properties window. 

5. In a separate text editor (not within the course), replace every ampersand character 
(&) in the URL with this escape character string: &#038 
 
Example (with escape strings): 
http://media.pearsoncmg.com/ph/bp/bp_mylabs/akamai/template/video640x480.p
hp?title=azTeen_Magazine&#038clip=pandc/bp/2010/management/azteen.mov&#0
38caption=bp/bp_mylabs/akamai/2010/management/xml/azteen.adb.xml 

6. Copy the new URL and paste it in the URL box in the Link Properties window.  

7. Enter a Description and click Set. 

8. Click Save. 

October 2011 

What's new 

Course Roster displays students' temporary access expiration dates 

Instructors can view their students' temporary access expiration information in the Course 
Roster. The temporary access expiration date appears in red text below the student's 
name; for example: "Temporary course access expires on: Nov 10, 2011." If a student's 
temporary access is active, the student's Role cannot be changed during the temporary 
course access period. If a student's temporary access is inactive and has expired, the 
student's entire row is disabled, preventing the instructor from changing student’s Role or 
Status. The expired date appears in red below the student's name; for example: 
"Temporary access expired: Sept 17, 2011." Students now have the ability to view and 
access their course on the last day of the subscription end date. (Released October 23, 
2011.) 

Submissions 

The Submissions tool provides a central location for instructors and students to submit and 
retrieve documents with comments. Note: Publishers can customize courses. The Submissions 
tool might not be available in your course. (Released October 12, 2011.) 

Course Scheduler 

The Course Scheduler allows instructors to set, change, and remove due dates for course 
items. Instructors can view all due dates for scheduled items by switching to “view all.” This 
feature shows the Course start date and Course end date as reference for scheduling 
items. The due dates instructors set using the Course Scheduler display in the Upcoming 
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section of the enhanced Course Home. Note: Publishers can customize courses. The Course 
Scheduler might not be available in your course. (Released October 12, 2011.) 

Resolved issues 

Temporary access payment is possible after Enrollment End Date has passed 

An issue preventing temporary access payment after the course enrollment end date has 
passed has been resolved. 

Content upload now works Firefox 7 

An issue preventing file upload in Firefox 7 has been resolved.  

Known issues 

Content upload fails in Firefox 7, error occurs 

Issue: It is not possible to upload files in Firefox 7 in the following MyLab / Mastering new 
design areas: 

• modify settings > Manage Files 
• Uploaded Content: modify > Upload Content (PDF, HTML, etc.) 
• Uploaded Content: modify > Upload MS Office File 
• Syllabus: modify > Manage > Upload Microsoft Word Syllabus (.doc) 
• Document Sharing > Upload Document 
• Email > Add Attachments 

Any attempt to upload files results in the following error: "The file which you are trying to 
upload is empty or cannot be found. Please select a valid file to upload." 

Workaround: Until the issue is resolved, you can upload files to your MyLab / Mastering 
new design course using a different browser: Internet Explorer 8 or 9, Chrome 14, or 
Safari 5. You may also use Firefox 6. We are actively working to resolve this issue. 

Some users cannot sign in with Internet Explorer, and receive the error message “We 
are sorry. Your course did not load properly.” 

Issue: When attempting to sign in to the MyLab / Mastering site, the error message “We are 
sorry. Your course did not load properly” appears for some users in Internet Explorer. This 
can occur in IE7 and IE8. 

Workaround: Change the following IE option: 

1. Click on Tools > Internet Options. 

2. Click the Advanced tab. 

3. Under the Security heading, check "Enable native XMLHTTP support." 



Copyright © 2019 Pearson All Rights Reserved 36 

4. Click Apply. 

5. Click OK. 

September 2011 

What's new 

Social Course Home features enabled 

Social Course Home provides a set of features for students and instructors to interact with 
one another through personal and activity feeds, discussion posts, and remarks. Other 
features provide course updates, including announcements, upcoming events, and course 
submissions awaiting review. Note: Publishers can customize courses. Social Course Home 
features might not be available in your course. (Released September 28, 2011.) 

August 2011 

Known issues 

Temporary access payment fails if Enrollment End Date has passed 

Issue: If the Enrollment End Date that the instructor set for a course has passed, temporary 
access payments will fail. 

Workaround: Instructor's should extend the Enrollment End Date for the course for 17 
more days to allow temporary access payments to go through. (Released August 31, 2011.) 

July 2011 

What's new 
Gradebook and assessments 

MyLab and Mastering new designs now provide a gradebook and assessments. Not all 
courses will use these features, as some course disciplines provide their own gradebook 
and assessment tools. (Released July 14, 2011.) 

Resolved issues 
Course creation failures for XL instructors 

The issue with XL course creation course failures for some existing XL users has been 
resolved.  

Course Roster in IE7 

For Internet Explorer 7.0, a course roster launching issue has been resolved.  
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The redesigned Courses page (myPearson page) now loads correctly in IE without 
clearing the cache 

Users no longer need to clear the cache in Internet Explorer to correctly view the new 
design of the Courses page (myPearson page). 

Security warning 

An Internet Explorer security warning issue has been resolved. Users signing in through 
Internet Explorer should no longer see a security warning message. 

Archive menu item feature now archives and restores nested menu items 

Users can now archive nested menu items along with a "parent" menu item to the Restore 
tab in one step. If the parent menu item is then restored, the nested menu items are also 
restored with it automatically to the bottom of the course menu. 

Known issues 

Content page does not load after clicking a menu item 

Issue: After clicking a menu item in the course menu, the content pane may not load and 
appear blank. 

Workaround: Click the menu item again to display that specific menu item's content, or 
clear the temporary files from your browser's cache to ensure that all content throughout 
your course displays correctly. 

Course banner may not load correctly (text string $fullName may appear in place of 
the user's name) 

Issue: In some courses, the course banner loads the ${fullName} string instead of the 
user's full name. Some user's may also see a 404 error after clicking the Courses link or 
Sign Out in the banner. 

Workaround: To fix this issue, clear the temporary files from your browser's cache. This 
issue may be prevented by using a supported browser. See System Requirements for a list 
of currently supported browsers.  

June 2011 

What's new 

Updated design for MyLab and Mastering sign in and course list pages 

The MyLab and Mastering sign in and course list pages were updated to incorporate the 
new Pearson design. (Released June 26, 2011.) 

http://pearsonmylab.com/system-requirements
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Resolved issues 
Course delete is supported 

The course delete feature is now available for instructors. 

Known issues 

The myPearson Page and Courses list do not load correctly in IE 

Issue: The myPearson page, including the Courses list, were redesigned. In Internet 
Explorer, pages load incorrectly at first sign in due to a caching issue. (This is not an issue 
for other browsers.) 

Workaround: To fix this issue, you must clear the temporary files from your Internet 
Explorer cache. To do this, refer to the following Pearson Technical Support article: Delete 
Browser Cached Files and Cookies. 

Time zone shown does not match instructor setting (default system time zone is 
displayed) 

The default system time zone is automatically displayed for most tools in a course, 
including Announcements and Discussions. The default system time zone cannot be modified 
by users. However, some courses are designed to allow users to set the time zone for 
particular settings, such as course availability. In these cases, the time zone for this setting 
is inconsistent default system time zone. This cannot be reconciled in the software, so 
instructors should be aware of this inconsistency, and calculate availability times with time zone 
differences of students in various locations in mind. 

Note: The default system time zone is (GMT-05:00) Eastern Time (US & Canada). 

May 2011 

Resolved issues 
Monitoring console in IE7 

An issue with Internet Explorer 7.0 in which a monitoring console sometime appeared at 
the bottom of the page has been resolved. (Released May 4, 2011.) 

https://support.pearson.com/getsupport/s/article/Deleting-Browser-Cached-Files-and-Cookies
https://support.pearson.com/getsupport/s/article/Deleting-Browser-Cached-Files-and-Cookies
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March 2011 

What's new 

New Uploaded Content menu item type and enhanced Microsoft Office® document 
and web content upload 

The new Uploaded Content menu item type is available on the Add tab. This menu item 
type associates web content (PDF, HTML, and other file types) and Microsoft Office® 
documents (.doc, .xls, .ppt) with a menu item. To add an Uploaded Content menu item, 
click modify above the course menu and click Add, then select the Uploaded Content 
menu item type. To upload content, navigate to the new menu item, then click modify > 
Upload Content (PDF, HTML, etc.) or modify > Upload MS Office File to upload content 
to the page. To view the content, click modify > View. (Released March 15, 2011.) 

Full screen control 

A new full screen control was added. Click the expand icon to the left of the content pane 
heading to expand the content pane to fill the browser window and hide the course menu 
and banner. To display the hidden course menu and banner, click the collapse icon next to 
the content pane heading. (Released March 15, 2011.) 

Expand menu items 

Clicking a menu item name expands the course menu to display nested menu items. 
(Released March 15, 2011.) 

Expansion state preserved 

The course menu displays the expansion state of menu items on the Arrange tab after 
closing Modify Course Menu. (Released March 15, 2011.) 

Resolved issues 

Saved edits might not appear immediately in IE 

A caching issue in IE in which saved changes in the content editor (visual editor) did not appear 
immediately when selecting modify > View has been fixed. 

Nested menu items do not inherit instructor icons 

An issue where nested items did not inherit a parent item's instructor (hide from students) 
icon has been fixed. Menu items moved into hidden menu items now inherit the instructor 
icon and display correctly. 
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Ampersand character code appears in browser headings 

An issue causing the ampersand (&) character code to appear at the top of the browser 
window or browser tab when "&" is used in item name has been resolved. 

Dashes in content item titles cut off text 

An issue with dashes in content item titles causing any text after the dashes to be cut off 
has been resolved. 

Long menu item names do not wrap correctly 

A wrapping text issue for long menu item names has been resolved. Long menu item 
names now display at full left justification. 

Known issues 

Collapsed visual editor frame hides the Save Changes button 

Issue: When a user works in the visual editor in expanded, full screen mode then reverts to 
the collapsed screen (showing the course menu), the Save Changes button is hidden under 
the edge of the editor frame. It is not possible to save changes. This issue occurs with any 
browser. 

Workaround: Click the full screen icon to expand the screen (hiding the course menu). The 
Save Changes button becomes visible and accessible. 

Long menu item names are shortened in headings and followed by an ellipsis ( … ) 

Issue: When a long menu item is selected in the course menu, the menu item's name is 
truncated and followed by an ellipsis in the content pane. 

Workaround: There is no workaround for this issue. 

Long menu items overlap instructor icon 

Issue: For hidden menu items with long names, the menu item text overlaps the instructor 
icon in the course menu. 

Workaround: There is no workaround for this issue. 

Video uploads add extra blank space 

Issue: Extra blank space is added after the page heading in the content pane of Uploaded 
Content menu items when a video file is uploaded.  

Workaround: There is no workaround for this issue. A fix is planned for a future release. 
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February 2011 

Resolved issues 

Incomplete logout 

An issue with incomplete logout has been resolved. (Released February 2, 2011.) 

Known issues 

Course name change delay 

Issue: There may be a delay updating the course title in the Courses list after you change 
the name of the course.  

Workaround: There is no workaround for this issue. 

January 2011 

What's new 

Style tab 

The Style tab is implemented. Click modify above the course menu and click Style to set a 
menu color scheme. (Released January 12, 2011.) 

Resolved issues 

Move menu item in IE7 

An issue with moving menu items in Internet Explorer® 7.0 has been resolved.  

Rename menu item in IE7 

An issue with renaming menu items in Internet Explorer 7.0 has been resolved.  

Add page in IE7 

An issue with adding a page in Internet Explorer 7.0 has been resolved.  

Clicking Enter on the Add tab displays a blank screen 

While adding a menu item using the Modify Course Menu Add tab, you can now click Enter 
in the Menu Item Name text box to enter the new name. 

Hiding parent menu item doesn’t hide nested menu items 

If you hide a (parent) menu item that contains other menu items by clearing its Show to 
Students checkmark, the nested menu items are now hidden automatically. 
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Known issues 

Course Roster in IE7 

Issue: In Internet Explorer 7.0, the course roster in new design courses may not launch 
reliably the first time you attempt to click on it within a given session. If this occurs, close 
the roster window and try again.  

Workaround: If possible, upgrade Internet Explorer to version 8.0 or use a different 
browser. See the System Requirements for a list of supported browsers. 

Monitoring console in IE7 

Issue: In Internet Explorer 7.0, a monitoring console can sometimes appear at the bottom 
of the page. 

Workaround: If possible, upgrade Internet Explorer to version 8.0 or use a different 
browser. See the System Requirements for a list of supported browsers. 

Saved edits might not appear immediately in IE 

Issue: In IE, saved changes in the content editor might not appear immediately. In this 
case, the changes are actually saved, but you need to refresh your cache. 

Workaround: To refresh, right-click and select Refresh in the content pane. 

Incomplete logout 

Issue: Logging in to a new design course after another user logs out on the same machine 
can lead to an error message. The error message, displayed in three languages, refers to a 
problem with the page you are accessing. 

Workaround: Clear the cache by following your browser’s instructions, then log in again. 

Quick Reference display issues on Mac 

Issue: In some Mac browser versions, the Quick Reference PDF appears grayed out. 

Workaround: To view the document, save the PDF locally and load it directly into your PDF 
reader. You can also print the document from your browser, and the printout appears in 
the correct hues. See the System Requirements for a list of supported browsers. 

http://www.coursecompass.com/html/system_requirements.html
http://www.coursecompass.com/html/system_requirements.html
http://www.coursecompass.com/html/system_requirements.html
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December 2010 

What's new 

New Designs 

Courses with 2012 copyright titles reflect the new CourseCompass course design. The new, 
intuitive design provides enhanced functionality for customizing courses and 
communicating with students. 

Supported tools include Discussions, Course Roster, Email, File Upload, Syllabus, Document 
Sharing, and Elluminate® Chat and ClassLive. (Released December 27, 2010.) 

Known issues 

Move menu item in IE7 

Issue: If you use Internet Explorer® 7.0 to access your "New Design” course, the command 
to move a menu item does not work.  

Workaround: If possible, upgrade Internet Explorer to version 8.0 or use a different 
browser. See the System Requirements for a list of supported browsers. 

Rename menu item in IE7 

Issue: If you use Internet Explorer® 7.0 to access your “New Design” course, the command 
to rename a menu item does not work.  

Workaround: If possible, upgrade Internet Explorer to version 8.0 or use a different 
browser. See the System Requirements for a list of supported browsers. 

Add page in IE7 

Issue: If you use Internet Explorer® 7.0 to access your “New Design” course, adding a page 
does not work.  

Workaround: If possible, upgrade Internet Explorer to version 8.0 or use a different 
browser. See the System Requirements for a list of supported browsers. 

Security warning 

Issue: If you use Internet Explorer to access your “New Design” courses, you might see a 
security warning dialog. The warning appears because some “New Design” resources are 
delivered using the HTTP protocol rather than the HTTPS protocol. 

Workaround: 

Internet Explorer 7. If you are using IE 7, click Yes in the security warning dialog to proceed 
to your course. Clicking No will result in the error message: "Navigation to the webpage 
was canceled."  

http://www.coursecompass.com/html/system_requirements.html
http://www.coursecompass.com/html/system_requirements.html
http://www.coursecompass.com/html/system_requirements.html
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Internet Explorer 8. If you are using IE 8, click No in the security warning dialog to proceed to 
your course. Clicking Yes will result in the error message: "Navigation to the webpage was 
canceled."  

In Internet Explorer 7 and 8, you can avoid these messages by updating your security 
settings as follows: 

1. Click Tools > Internet Options > Security.  

2. Click Custom level.  

3. Under Miscellaneous, for Display mixed content, click Enable, then OK. 

Course delete not supported 

Issue: At this time, you cannot delete a "New Design" course.  

Workaround: No workaround exists at this time. This feature will be available in an 
upcoming release. 

Course upgrade not supported 

Issue: At this time, you cannot upgrade a "New Design" course.  

Workaround: No workaround exists at this time. This feature will be available in an 
upcoming release. 

Clicking Enter on the Add tab displays a blank screen 

Issue: While adding a menu item using the Modify Course Menu Add tab, if you click Enter 
in the Menu Item Name text box, a blank screen results.  

Workaround: Click the Back button on your browser and return to the Add tab to add your 
menu item. 

Archive menu item feature does not archive nested menu items, but moves them 
into previous menu item 

Issue: When archiving a "parent" menu item, nested menu items move into the menu item 
above it in the course menu, rather than into the Restore tab.  

Workaround: To avoid this issue, be sure to first archive nested menu items by clicking 
modify > Arrange before archiving the "parent" menu item. Use the Restore tab to restore 
menu items as needed. 

Hiding parent menu item doesn’t hide nested menu items. 

Issue: You hide menu items from students by clearing the Show to Students checkmark 
on the Modify Course Menu Arrange tab. If you hide a (parent) menu item that contains 
other menu items, the nested menu items are not hidden automatically. 

Workaround: You have to clear the Show to Students checkmark for each of the menu 
items below the parent menu item. This issue will be resolved in an upcoming release. 
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